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Arduino nedir?

Arduino Cag1 Basliyor

Arduino kolay bir sekilde gevresiyle etkilesime girebilen
sistemler tasarlayabileceginiz, hem acemi hem de ileri
diizeydeki elektronik meraklilarina hitap eden, kolayca
programlanabilen ve iizerine elektronik devre kurulabilen
agik kaynakli bir gelistirme platformudur.

ARDUINO

arduino.cc

Fiziksel Diinya i¢in Bir Bilgisayar

Bu elinizde tuttugunuz dost canls: mavi karti masatisti
bilgisayarlarimizin ve laptoplarmnizin gocugu gibi
tagmabilir kiigiik bir bilgisayar olarak diistinebilirsiniz.
Arduino kiitiiphaneleri ile mikrodenetleyicileri
kolaylikla programlayabilirsiniz. Analog ve dijital
girigleri sayesinde analog ve dijital verileri isleyebilir ve
sensorlerden gelen verileri kullanarak dis diinyaya
ciktilar (ses, 151k, hareket vs...) retebilirsiniz.

Arduino kartlar1 bir Atmel AVR mikrodenetleyici

programlama ve diger devrelere baglanti i¢in N\ /7
gerekli yan elemanlardan olusur. Her kartta en

azindan bir 5 voltluk regiile entegresi ve bir J— —
16MHz kristal osilator (bazilarinda seramik

rezonator) bulunur. Mikrodenetleyiciye dnceden
bir bootloader programi yazili oldugundan
programlama igin harici bir programlayicrya
ihtiya¢ duyulmaz.

/ ARDUINO \

// Arduino UNO smp r3

Arduino Uno en yaygin kullanilan arduino kartidir.
14 dijital giris / ¢ikig'a (6 PWM g¢ikis1), 6 analog
girise, bir 16 MHz kristal osilatore, bir USB
baglantisina, bir giig girisine, bir ICSP baghgina ve
bir reset diigmesine sahiptir. Heyecana kapilmaya
gerek yok egitim igerisinde tekrar bu konulara
deginilecektir.§imdilik yiizeysel olarak bilinmesi
yeterlidir.




e Sayach Bocek Yakalama o Kamera Zamanlama Uygulamasi 0 Kahve Makinesi
0 Oyuncaktan Email Habercisi o Otomatik Cigek Sulama o Quadcopter
0 Otomatik Ayakkab1 Bagcigi o Programlanabilir Trafik Isiklar1



Arduino IDE'yi Indirme (Entegre Gelistirme Ortami)

Internet Erisimi

Arduino ile yazihm gelistirmek ve ¢alistirmak icin 6ncelikle
www.arduino.cc sitesinden bir Arduino Entegre Gelistirme
Ortami indirmeliyiz. Arduino IDE olarak bilinen bu yazilim
arduino 'yu programlamak icin adeta bir kelime islemci
gorevi gorecektir. Internet tarayicinizdan asagidaki adrese
tiklayarak size uygun Arduino IDE ‘yi indirebilirsiniz.

m arduino.cc/en/Main/Software

7
Kullandiginiz isletim sistemine gore size uygun

Yiikleme olan Arduino programini segmek igin arti(+)
isaretine basmaniz yeterlidir.

+ Windows
+ MacOS X
4+ Linux: 32 bit, 64 bit

+ source

ARDUINO =
— T R

Dowalned the Arduing Software

0 Bilgisayarmsz, igin aygun isletim sistemine gore yiikleme paketi seqmeyi unutmayimsz.



/I Arduino Uno'yu Bilgisayara Baglamak

Arduino ve Bilgisayar1 USB ¢ikislarindan USB Kablosu ile bagliyoruz.

il
I jls

// Surticii Yiikleme

Windows Siiriicii Yiikleme
Asagidaki adreste Windows siirticii yiiklemesi ileilgili
talimatlar1 bulabilirsiniz.

3 Bilgisayarinizin isletim sistemine gore ihtiyaciniz olan siirticiiyti indirip yiiklityoruz.

bttp://arduino.cc/en/Guide/Windows

Macintosh OS X Siiriicii Yiikleme

/ = > Asagidaki adreste MacOSX stirticii yiiklemesi ile ilgili talimatlar
- bulabilirsiniz.
\ _ 4

bttp://arduino.cc/en/Guide/MacOSX

Linux: 32 bit / 64 bit Siiriicii Yiikleme

Asagidaki adreste Linux stirticti yiiklemesi ileilgili talimatlar:
bulabilirsiniz.

bttp://www.arduino.cc/playground/Learning/Linux



//Arduino IDE yi A¢iyoruz:

Oncelikle bilgisayarimiza indirdigimiz arduino gelistirme programini
agalim. Programlamaya ge¢gmeden 6nce biraz gelistirme ortamini
kurcalayalim.




(¢10] | (Grafik Kullanic1 Arayiizii)

1 Verify(Derleme): Yazmis oldugunuz kodu derler. Soz dizimi hatalarinizi bulur.

Ozellikle ha
7 ' Sketch Name: $u an da iizerinde caligtiginiz sketch in adim gosterir.
8 Code Area(Kod Alani): Sketch igin kod olusturacaginiz alandr.

9 Message Area(Mesaj Alani1): Kodunuzdaki hatay: gosteren alan .

// Bu klavuz i¢in en 6nemli ii¢ komut agagida goriilmektedir:

Open(Ag¢mak)

Verify(Derleme)

Upload(Yiikleme)




// Seri aygit1 Segmek

//Kartimiz1 Secelim: Arduino Uno

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Port

Programmer
Burn Bootloader

, > WL

> Arduino Duemilanove w/ ATmega328]

Arduino Diecimila or Duemilanove w/ ATmega168
Arduino Nano w/ ATmega328

Arduino Nano w/ ATmega168

Arduino Mega 2560 or Mega ADK

Arduino Mega (ATmega1280)

Arduino Mini

Arduino Mini w/ATmega168

Arduino Ethernet

Arduino Fio

Arduino BT w/ ATmega328

Arduino BT w/ATmega168

LilyPad Arduino w/ ATmega328

LilyPad Arduino w/ ATmega168

Arduino Pro or Pro Mini (5V, 16 MHz) w/ATmega328
Arduino Pro or Pro Mini (5V, 16 MHz) w/ATmega168
Arduino Pro or Pro Mini (3.3V, 8 MHz) w/ATmega328
Arduino Pro or Pro Mini (3.3V, 8 MHz) w/ATmega168
Arduino NG or older w/ ATmega168

Arduino NG or older w/ ATmega8

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Board 4
Seralpor >
Aygitimiz icin uygun olan seri portu segmek icin Tools com 12
V8 . S g" = P ek g Programmer
>Setial Port mentisiine tikliyoruz. Genelde com3 veya Burn Bootloader
tizeridir (COM1 ve COM2 genellikle donanim seti portu
olarak kullaniimaktadir). Kullanacagmniz arduino portunu
bulmak i¢in Arduino ile bilgisayar arasindaki baglantiyt
kesin ve meniiye tekrar gelin ,baglantiy1 kestikten sonra
menude kaybolan pott sizin Arduino portunuzdur.
O portu secip arduino programlamaya baslayabiliriz.
I Auto Format
Archive Sketch
~ Fix Encoding & Reload
L& Serial Monitor
A ad Board »
Serial Port » /dev/tty.usbmodem262471
/dev/cu.usbmodem262471
Programmer »

Aygitimiz icin uygun olan seti portu segmek icin Tools
>Serial Port meniisiine tikliyoruz.Mac bilgisayarlarda
Uno veya Mega 2560 icin (/dev/tty.usbmodem) ve
ya eski kartlar icin (/dev/tty.usbserial) seciyoruz.

g

/dev/tty.Bluetooth-Modem
/dev/cu.Bluetooth-Modem
/dev/tty.FireFly-7256-SPP
/dev/cu.FireFly-7256-SPP
/dev/tty.tiPhone-WirelessiAP-1
/dev/cu.tiPhone-WirelessiAP-1
/dev/tty.Bluetooth-PDA-Sync
/dev/cu.Bluetooth-PDA-Sync

Burn Bootloader

http://www.arduino.cc/playground/Learning/Linux



AkademikPort Arduino Kodu indirme ( Kitapgigimizdaki Devreleri Olusturmak I¢in)

AKADEMIKPORT

Indirmek igin agagidaki baglantiy1 takip edin;

kitap.akademikport.com

° — [ start —» [ Programs —¥» [ arduino —» [ examples

Adreste verdigimiz
sikistirilmis dosyayi indirip,
icerisindeki “Arduino Kod”
dosyasini digari ¢ikartiyoruz.

“Arduino Kod” dosyasini kopyalayip arduino kurulumu
icerisindeki "examples" klasoriiniin igerisine yapistirtyoruz.

@ Contents

2 e '
8 Resources

s } |
E ) Arduino 'yu uygulama dosyasindan *

buluyoruz. Arduino 'ya sag

| Java
o tikliyoruz(ctrl + click) . “Show
Adreste verdigimiz sikistirilmig Package Contents” 'i seciyoruz. *
dosyay1 indirip, icerisindeki
« . . 8 examples
Arduino Kod” dosyasini digar1 Arduino
kartiyoruz. Open . ,
S 4 ‘Arduino Kod” dosyasini
Kopval 1
Move to Trash ©OoyelEp el
Kklasoriiniin ierisine
vapistiryoruz.

http://www.arduino.cc/playground/Learning/Linux

\'"‘




Elektrik Devreleri

Elektrik Devresi Nedir?

Elektrik Devresi basitge baglangig ve bitis noktasi olan ve
igerisinde bir ¢ok devre elemani buluduran déngiidir.
Devreler her 6lgiide ve sekilde yiizlerce ; direng,diyot,
bobin,sensér, motor ve diger devre elemanlarini
barindirabilir.

Devreler genelde analog devreler,dijital devreler ve
karigik sinyal devreleri olmak tizere ii¢ kategoriye
ayrilir.Bu kitapgikta her ii¢ devre gesidi de
gosterilecektir.

Diinya Bu Devreler Uzerinde Doniiyor

Nereye bakarsaniz bakin devreler ile karsilasacaksiniz.
Cebinizdeki telefon, aracinizin emisyon sistemini
kontrol eden bilgisayar,oyun konsollariniz,elektrikli
mutfak aletleriniz , bunlarin hepsi elektrik devreleriyle
dolu. Bu kitapgikta bazi basit devreleri deneyecek ve
gomili elektronik sistemlerinin temeline adim

atacaksiniz.

+
I
o
o
o
o
@
ES
+
]

/1 Basit ve Karmagik Devreler

Bu kitapgikta ilk olarak basit devreleri
kesfedeceksiniz. Ama bu sizin basit araglarla
biiyiileyici seyler yapamayacaginiz anlamina
gelmiyor elbette. Bu egitimi tamamladiktan
sonra devreler hakkinda 6grendiginiz bilgiler
hayal giiciiniize de bagli olarak muhtesem
projeler yapmanizi saglayacak.
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Devre Elemanlari

Atlama Kablosu
Cesitli Renklerde

/

Il

LED (5mm)
(Light Emitting Diode)

x10

([e—=

x1

3300 Direng
&
x25 Gergek Goriiniim

10KQ Direng

x25

&

Gergek Goriiniim

Potansiyometre

¢ B

Diyot
(1N4148)

“Gergek Goriiniim

Foto Direng¢(Lpr)

Buzzer

Sicaklik Sensorii Transistor -
D<o
e B || oo, BB
ON ON
x1

DC Motor

)i

Push Buton
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Servo Motor

Role

x1

Entegre (i)
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Arduino Uno

9-12V DC Giig Girisi( Barrel Jack) - 9V veya 12V gii¢ baglanabilen giic girisidir .
USB Baglant1 Konnektorii(USB Port) - Arduino 'ya program yiiklemek ve bilgisayar ile haberlesmek i¢in kullanilan baglant1 konnekterd:
LED(RX: Receiving) - Seri haberlesme i¢in kullanilan RX pininin durumunu gésteren LED'dir. Veri alisverisi oldugunda bu led yanar.

LED(TX: Transmitting) - Seri haberlesme i¢in kullanilan TX pininin durumunu gosteren LED'dir. Veri aligverisi oldugunda bu led yanar.

LED (Pin 13: Troubleshooting) - 13 Nolu dijital pine bagh olan LED'dir. Programlar: test etmek i¢in kullanilabilir.

in kullanilan pinler burada bulunuyor.Yaninda isareti bulunan pinler aym
LED (Gii¢ LED"i)-Kartimizin gii¢ gosterge LED 'idir. Devrelerinizi kurarken kisa devre yapip yapmadiginiz bu LED 'e bakarak anlayabilirsiniz.
Reset Butonu -Arduinoyu yeniden baslatir.Programlarimiz setup() fonksiyonundan itibaren yeniden baslar.
Kart Uzerinde Programlama(ICSP) Pinleri - Atmega microdenetleyiciyi harici bir programlayici ile programlama pinleri.

Anolog G1r1§ Pinleri ve Gllg: Baglantllarl =Anolog giris ve gerilim baglantilar1 bu béliimde bulunuyor.Ayrica analog-dijital
geviricinin referans giris pini ve seri iletisim pinleri de (RX ve TX) burada bulunuyor.

// Pin Diyagrami
Header pinleri devreleri kurmak igin en 6nemli yerlerdir. Biraz
o zaman ayir1p arduino uno iizerindeki giris ¢ikiglara goz gezdirelim.
SCL B
SDA
AREF ARef
— GND Ground
AR 13 Digital
IOREF »
12 Digital
Reset RESET
~11 Digital
Power Out 3.3v
~10 Digital
Power Out 5V
~9 Digital
Ground GND iak
o 8 Digital
Ground GND g
@ Power In VIN T 7 Digital
g ~6 Digital
Analog Ao ° = Digital
Analog Al - 4 Digital
> 2 1
Analog A2 § s -3 Digital
Analog A3 5 E 2 Digital
Analog A4 ; ™S1 X - Out
Analog A5 RX < 0 RX-In

@)

O

A =PWM/Analog ¢ikis uyumlu (i.e~3)
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Bu ¢izgi breadboardumuzu ikiye boliiyor,Her boliim kendi i¢inde bagimsizdir.




Breadboard

1 Dikey Baglantl (+ Giig ve - Toprak = Asagidaki diy: a B:

2 Yatay Baglanti (a-e&f-j Asagidaki diyagrama Bakiniz

+++++++

1

30|
+++++++
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Breadboardin f¢ Goriiniimii>>>
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Devreler #1 - Ilk Devren

Nasil Calistiracagiz;

Arduino' ya
Yiikle

3

2 Kodu Yaz

Parcalar1
Birlestir

1

+ USB Kablosunu Bagla

Breadboard hakkinda genel bilgiler verildi,
simdi arduino ile breadboardu yanyana
yerlestirelim ve talimatlara dikkat edelim.

+ Arduino ve Breadboardi yanyana yerlegtir

+

5V Akam Arduino 5V da galisir. Arduino'yu bilgisayara bagladiginizda aldigimniz gii¢

kurdugunuz devreleri galistiracaktir. Bilgisayarinizi Arduino'ya baglayarak dogru gerilimi

alabilirsiniz. 5V size zarar vermez bu ytizden devre icerisinde dokunmaktan korkmayin.




Elemanlar:

Pin 13 Arduino

LED
SZ (Light Emitting Diode)

Direng (330ohm)
(Turuncu-Turuncu-Kahverengi)
GND

(ground-toprak) (-)

+Bu LED yakma devremizin §emaS|dn]

LED 330Q Kablo
Direng

LED YAKMAK

LED 'ler (light-emitting diodes) bir ok elektroni
devrede kullanilan giiclii 151k kaynaklaridur.
Caligmalarimiza ilk olarak her elektronik
meraklisinin yaptig gibi led yakarak baslayacagiz .
Bir gogunuz igin ¢ok basit olabilir ama hem devre
kurma hem de programlama olarak bize katacaklar
seyler daha komplex projeleri yapmak igin bizlere
birer basamak olacaktir.

+ Bu boéliimde devrelerimizi kurmadan 6nce
kuracagimiz devre ile ilgili kisa agiklamalar
yer alir.

x1 x1 x3

+ Bu bdélimde, devreyi tamamlamak
icin gereken pargalar listelenir.

+ Devrenin nasil kurulacagini gésteren
semadir. Ozellikle yeni baglayan
arkadaglarin baglantilari kurmak igin
semayi dikkatle incelemesini tavsiye
ediyoruz.

+ Direng gibi devre elemanlarinin
breadboard ile baglantisini
saglamak i¢in bacaklarini 90
derecelik agiyla bikiiyoruz.
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. [P edit Sketch  Tools  Help

Bilgisayarimizdaki Arduino IDE yazilimini agiyoruz. Daha sonra asagidaki
semay takip ederek "examples" klasortii igerisindeki "Arduino Kod"
bolimiinden "Devre 1" kodunu segiyoruz.

New
Open...
Sketchbook »
1.Basics »
Close 2.Digital | 4
Save 3.Analog >
Save As... 4.Communication >
Upload 5.Control >
Upload Using Progammer 6.Sensors »
7.Displays | 4
Page Setup 8.5trings »
Print ArduinolSP
Devre #2
EEPROM Devre #3
Ethernet Devre #4
Firmata Devre #5
Liquid Crystal Devre #6
SD Devre #7
Servo Devre #8
SoftwareSerial Devre #9
SPI Devre #10
Stepper Devre #11
Wire Devre #12
//Devre #1

Circuit #1

7
Led Yakmak (Blink=G6z Kirpma)
LED 'i bir saniye yakip bir saniye séndiiren program
*

/

int LEDcikis = 13;
void setup() {

// Dijital Pini gikig olarak ayarlayacagiz.

pinMode(LEDcikis, OUTPUT);

}
void loop() { //LED'i yak

digitalWrite(LEDcikis, HIGH); // 1 saniye bekle
delay(1000); // LED'i sondiir
digitalWrite(LEDcikis, LOW); //1 saniye bekle

delay(1000);
}




Kodu derliyoruz. Yazilim kodu arduino tizerindeki entegrenin anlayabilecegi dile

geviriyor.

J Derleme‘

USB Kablo araciligiyla kodu Arduino tizerindeki entegreye gonderiyoruz. Daha sonra

devre otomatik olarak ¢alismaya baglayacaktir.

Yikleme

>

// Verilen kod ile derledikten ve yiiklendikten sonra breadboard iizerindeki LED yanip sonmeye baslayacaktir




+ Tum devrelerde kodlarin ne
oldugunu agiklayan boliimdiir.

‘ L Arduino IDE ‘yi A¢ // File > Examples > Arduino Kod > Devre # 1

Kod notlari: + Verilen Kodu derlemeyi(verify) o °
ve yiiklemeyi(upload) unutmayin

+ Kodun nasil galistigini anlamak icin
asagidaki agiklamari inceleyin.

Arduinoki pinleri kullanmadan 6nce pini INPUT (giris) yada
pinMode(13, OUTPUT); OUTPUT (gikss) olarak tanimlamaniz gerekmektedir . Bunu yapmak
icin pinMode() yerlesik fonksiyonunu kullanacagiz.

Bir pini OUTPUT (¢ikis) olarak tanimladiginizda, o pinin HIGH
(output 5 Volts-5 Volts ¢ikis), veya LOW (output 0 Volts-0 Volt ¢ikis)
olarak davranmasini saglayabilirsiniz .

digitalWrite(13, HIGH);

+ Devrenizi tamamladiysaniz,
asagidaki gibi LED yanip s6necektir

Ne gorecegiz?

Yanip sonen bir LED goreceksiniz. Eger
calismiyorsa kodu kontrol edin ve tekrar
derleyin sonra yiikleyin ve devreyi tekrar
kontrol edin veya asagidaki sorun giderme
ipuglarini bakin.

+ Bu alan kurdugunuz devrenin ve devre
elemanlarinin gergek hayattaki
kullanimlarini igerir.

+ Bu boliim devre montaji sirasinda yapilan
en yaygin hatalari igerir.

Sorun Giderme: Gergek Hayatta Uygulamalar::

LED Yanmryor Hemen hemen tiim modern televizyon ve
LED sadece tek yonlii galisir. Bu tiir sorunlar monitdrlerde tirtintin galistigini ya da standby
genelde LED in yanlis bacaginin baglanmasindan durumunda oldugunu gosteren LED ler bulunur.

kaynaklaniyor. Endiseye gerek yok Led in
bacaklarini ¢evirin ve yeniden baglayin.
Program Yiiklenmiyor

Yiikleme ile ilgili sorunlar genelde seri port dadr.
tools>serial port> sekmesinden portunuzu degistirip
tekrar yiiklemeye ¢alisin.

Hala Galismiyor mu?
Tamamlayamadigmiz her devreniz hakkinda yardim

almak igin emrearslan@elektrikport.com adresine mail o
yollayabilirsiniz. 8




Devre #2

Potansiyometre

+5 Volt Bu devrede potansiyometrenin ne ise yaradigini
Ogrenecegiz. Potansiyometre degisken bir direng
m Arduino Potansiyometre Arduino olarak bilinir. Tki gikis pini 5 Volta baglandiginda
Pin AG ortadaki pin potansiyometredeki kontrol
diigmesinin konumuna gére 0V ile 5V arasinda
¢ikig verir. Bu devrede, LED parlakligini kontrol
\V4 LED D - . . b
etmek i¢in potansiyometreyi nasil kullanacaginizi

Ogreneceksiniz.

diren¢  (3300hm)
(turuncu-turuncu-kahverengi)

GND
(toprak-ground) (-)

Potansiyometre LED 330Q Kablo
/ Direng
x1 x1 x1 x6

Elemanlar:




Devre 2: Potansiyometre
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J L Arduino IDE yi A¢// File > Examples > Arduino Kod > Devre #2

Kod Notlar1: 0 °
"Degisken" sizin isim verdiginiz bir rakamdur. Degiskeni kullanmadan
. 6nce onu tanimlamali veya bildirmelisiniz; burada sensorValue adinda
int sensorValue; |:> e g G b
bir degiskeni "int" (integer-tamsay1) olarak bildiriyoruz. Bu degisken
isimlerinin kiigtik-bityiik harf duyarh oldugunu unutmayiniz.

Analog pindeki degeri okumak i¢in analogRead()
fonksiyonunu kullaniriz. analogRead() kullanmak istediginiz

sensorValue = analogRead(sensorPin); :> analog pindeki ("sensorPin") degeri okur ve bir
rakama("sensorValue") doniistiiriir, bu rakam 0 (0 Volt) ile
1023 (5 Volt) arasindadur.

Arduino her saniye binlerce satir kodu galistiracak kapasiteye sahip, gok
hizli bir yapidir. Onu yavaslatip neler yaptigini gézlemlemek i¢in bazen

delay(sensorValue); :> kodlar arasina ("delay")gecikmeler ekleriz. Delay() fonksiyonu
milisaniye ile sayar; yani 1 s gecikme igin parantez igine 1000ms
yazilmalidir.

Ne gorecegiz?

Potansiyometrenin ayarini
degistirdikge LED'nin hizli ve
yavas bi sekilde yanip
sondiigiini goreceksiniz. Eger
calismiyorsa kodu kontrol edin
ve tekrar derleyin sonra yiikleyin
ve devreyi tekrar kontrol edin
veya agagidaki sorun giderme
ipuglarmi bakin.

Sorun Giderme: Gergek Hayatta Uygulamalar::

Diizensiz Calisma Durumu MP?3 galarlardaki ses kontrolii potansiyometre
Biiyiik olasilikla potansiyometrenin pinlerinin kullanimina bir 6rnektir.
breadboarda tam oturmamasindan
kaynaklanabilir. Potansiyometreyi bastirarak bu
sorunu ¢ozebilirsiniz.

Calismama Durumu
Potansiyometrenin 2. pinini analog pin yerine dijital
pine baglamadiginizdan emin olunuz.

Hala Calismiyor mu?

Tamamlayamadiginiz her devreniz hakkinda
yardim almak i¢in emrearslan@elektrikport.com
adresine mail yollayabilirsiniz.




Devre #3

RGB LED

Pin 11 Pin 10 Pin9

I i I I h I I i I Yanip sonen bir LED’den daha eglenceli sey nedir
sizce? Tabi ki renkli LED'ler! RGB, yani red-blue-
green LED'ler 3 adet renk barindiran ve her tiir

g;;z:;) renk i¢in kombin edilebilen bir diyot tirtdiir. Bu
P— devrede Bir RGB LED kullanarak nasil renk
- = T kombinasyonlar1 olusturabileceginizi
z = g 6greneceksiniz. Her bir diyotun parlakligina bagh
Av4 olarak neredeyse biitiin renkleri elde etmeniz
miimkin.
—1L _ GND
— (toprak-ground) (-)
é LED 330Q Kablo
E Direng
= x1 x3 x6




Devre 3: RGB LED
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JL Arduino IDE 'yi A¢// File > Examples > Arduino Kod > Devre # 3

Kod Notlare:

for (x = 0; x < 768; x++)
{}

if (x <= 255)

zlse :>

{}

delay(sensorValue); :>

Ne gorecegiz?

LED'inizi galistyor olarak gérmeniz
lazim, fakat bu sefer LED'iniz
sirayla farkli farkli renkler yayiyor
olmal. Eger oyle degilse devrenizi
dogru sekilde birlestirdiginizden
emin olun, kontrollerinizi yapin ve
kartimiza yiikleme yapin ve ariza
tespiti kismuini kontrol edin.

Sorun Giderme:

LED'in Isik Vermemesi veya Yanlis Renk Vermesi
LED'in dért pini birbirine ¢ok yakin bulunmakta,
kolayhkla yerlerini karistirabilirsiniz. Pinlerin nerede

olmas: gerektigini iki kez kontrol edin. Ayrica uzun LED'kullamlm:aldadJr. Bu '
" . LED/ler ayn1 bolgede farkls
ug bazen GND olmayabilir, uzun ucu Arduino renkleri gostermek igin []
kartimizin 5v gikigina bag tekrar deneyiniz.
an 5v gilastna baglayp tekrar deneyiniz kullaniliyor. Siklikla farkl:
Kirmizi Rengi Gormek renkler farkh calisma U
RGB LED i¢ersindeki kirmiz1 diyot diperlerinden daha sartlarini ifade eder 5

parlak olabilir. Renklerinizi daha dengeli hale getirmek
i¢in daha yiiksek bir direng kullanin veya kodunuzda

ayarlamalar yapin.
analogWrite(RED_PIN, redIntensity);

to

analogWrite(RED_PIN, redIntensity/3);

Bir for() dongiisti bir aralikta say1 yerlestirmek icin kullanilir ve
tekrarlayarak brackets{} igerisinde kodu galistirir. Degisken bir “x” 0 olarak
basliyor ve 767 sayisina kadar her adimda bir artarak ilerliyor ("x++")..

“If / else” ifadeleri programinizda segim yapmak i¢in kullamlir. Parantez ()
icerisindeki ifade degerlendirildiginde, eger ifadesiniz dogru ise ilk brackets{}
icerisindeki ifade ytiriitiiliir. Sayet dogru degil ise ikince brackest {} igerisindeki
ifade yiiriitiiliir.

Arduino ¢ok hizh ¢aligbilmektedir. Oyle ki her saniye binlerce kod
satirini gahistirabilecek kapasiteye sahiptir. Biz de cihazin ne yaptigini
gorebilmek i¢in yavaslatmak adina gecikmeler ekliyoruz. Delay()
milisaniye olarka hesaplaniyor; 1 saniye 1000 milisaniye.

Videogame konsollar gibi
bir gok elektronikte RGB =




Elemanlar’

Coklu LED

Elimizde yakip s6ndiirmek igin bir LED var. Gelin
simdi SEKIZ LED'i anda baglayarak gitay1 biraz
yiikseltelim. Boylece ¢esitli renkler olusturma
konusunda Arduinomuzu da ufak bir teste tabi
tutmus olacagiz. Bu devre kendi programinizi yazma
pratikleri igin giizel bir baglangi¢ adimi olacak.
LED'leri kontrol asamasinda yazdiginiz programi
diizenli tutmanizi saglayacak bir kag ipucu
Ogrenceksiniz.

for() loops - Bu dongii birden fazla kez aym
kodu kullanmanizi saglar.

arrays[ ] - Birden fazla degiskeni grup haline
getirerek yonetilmelerini kolaylagtirr.
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Devre 4: Coklu LED
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{ ,J Arduino IDE 'yi A¢// File > Examples > Arduino Kod > Devre # 4

Kod Notlari: 0 °

“array” ¢ok fazla degiskeni gruplar haline getirerek
yonetilmesini kolaylastiran en kullanigh yontemdir.
Burada sekiz eleman igeren integer degerler icin bir array
olusturuyoruz ve buna ledPins adini veriyoruz.

int ledPins[] = {2,3,4,5,6,7,8,9}; |:>

Array ierisindeki bir elemana bulunduklar1 adres yardimi
ile ulagirsiniz. {lk elemanin adresi 0, ikinci elemanin adresi 1,

:> vs. Bir elemana ulagmak i¢in “ledPins[x]” komutunu
kullanarak x yerine o elamanin adresini yazarsiniz. Burada
dijital pin 2' yi HIGH yapiyoruz.

digitalWrite(ledPins[0], HIGH);

Bilgisayarlarlar ¢alisma sirasinda ayni islemleri gerceklestirir fakat bazen

bir seylerin rastgele olmaisnu istersiniz, 6rnegin bir zar atma isleminde.
index = random(8); :> Random() fonksiyonu bunu yapmak icin en iyi yoldur. Daha fazla bilgi

i¢in adresi ziyaret ediniz.

http://arduino.cc/en/Reference/Random

Ne gorecegiz?

Tek LED yerine biitiin LED'lerin yanip
sondiigiinii gormeniz gerek. Eger sorun
varsa devreyi dogru sekilde
kurdugunuzdan emin olduktan sonra
kodunuzu kontrol edin ve ariza tespit
kismini inceleyin.

Sorun Giderme:

Baz1 LED'ler Isik Vermeyebilir Kayan yaz1 ekranlar1 genellikle 5nemli bilgilarin kisa
LED'inizi ters takmus olabilirsiniz, sik¢a kargilagilan pargalarinin yaymlanmas: seklinde kulanilir. Bu
bir sorundur. Calismayan LEDinizin dogru ekranlar ¢ok sayida LED kullanilarak tretilir.

baglandigindan emin olun.

Siralama Diizeni
Sekiz adet baglant: ile galistiginiz igin karigikhiklar
olmasi gayet dogal. {lk LED'i pin 2’ye yerlestirin ve

™ 1 . . .. s e e e . b . e eee see .. .
diger LED'leri devam edecek sekilde yerlestirin ve 80080800080008000808000800080808080808000808 £
tekrar kontrol edin. o e es tes 2es ses P e e R e
Yeniden Baglayin

Farkinda olmadan baglantiy1 yanls yere
kurabilirsiniz. Genelde her seyi gikarip tekrar
yerlestirmek, nerede hata yaptiginiz aramaktan daha
kolaydir.



Devre #5

Buton Kullanimi

Su ana kadar ¢ikt1 (output) tizerine yogunlagsmistik.

+5 Volt Bundan sonraki projelerimize girdiler (inputs) ile

m M devam ediyoruz. Bu devrede gok yaygin olan bir

girdiye bakacagiz push botton(buton). Bir butonun

Arduino tizerindeki ¢aligma sekli soyledir; ne

| | zaman ki butona bastiniz, voltaj LOW seviyesine

\/ LED I I geger. Arduino bunu okur ve buna gére davranir.
—H —H | Bu devrede, bir adet pull-up direng goriiyoruz. Bu

| | direng temiz bir voltaj olugmasini ve butondan

Direng  (3300hm) gelecek yanlis okumalarin 6niine gegilmesini saglar.

(turuncu-turuncu-kahverengi)

—— GND
(toprak-ground) (-)

4 Push Button LED 10KQ 330Q Kablo
/ Direng Direng
x2 x1 x2 x1 x7




Devre 5: Buton Kullanim
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J L Arduino IDE 'yi A¢// File > Examples > Arduino Kod > Devre # 5

Kod Notlari:

pinMode(button2Pin, INPUT); |:>

button1State = digitalRead(button1Pin);

00

Dijital pinler ¢iktilar gibi girdi olarak da kullamilabilir.
Fakat bu islemi yapmadan 6nce, Arduinoya
kullandiginiz yolu séylemeniz gerek.

Dijital bir girdiyi okumak i¢in digitalRead()
fonksinonunu kullaniriz. Eger pinde 5V varsa HIGH,
0V ise LOW olacaktir.

Ciinkii butonumuzu GND’ye bagliyoruz ve butona bastigmizda
if (button1State == LOW) :> LOW olarak okunuyor. Buttonun basiimis durumda olup
olmadigimi gormek igin (“==") operatériinii kullaniyoruz.

Ne gorecegiz?

Buttona bastigimzda LED'in
yanip sondigiini gorebilirsiniz.
Eger sorun varsa devreyi dogru
sekilde kurdugunuzdan emin
olduktan sonra kodunuzu
kontrol edin ve ar1za tespit
kismini inceleyin.

Sorun Giderme:

Isik yanmiyor

Butonuzum kare oldugu igin yanlis yerlestirilmis
olabilir. 90 derece gevirin ve ¢alistyor mu tekrar
kontrol edin.

Isik sonmiiyor

Siklikla yaptigimiz bir hatadir. Isig1 kapatirken LED
baglantinizi pin 13' den pin 9'a getirmeyi unutmayin.

Butonlar bir ok oyun konsolunda kontrolit
saglamak i¢in kullanir.




Devre #6

Foto Direng

Pin 9 +5 Volt Potansiyometreyi énceki projelerimizde direnci
degistirmek i¢in kullanmustik. Bu devrede sensére
ulasan 151k miktarin gore direnci degisen foto
direngleri kullanacaksiniz. Arduino direnci direkt
olarak degerlendiremedigi i¢in foto direncimizi
kullanmak igin voltaj béliicii kullanacagiz. Voltaj
boliicii fazla 1g1k altinda yiiksek voltaj ¢ikisi, fazla
151k almadig1 zamanda da diisiik voltaj ¢ikist
verecek.

Foto
Direng

AV4 LED
Direng  (3300hm)
(turuncu-turuncu-kahverengi)

— GND
- (toprak-ground) (-)

resistor (10k ohm)
(Kahverengi-Siyah-Turuncu)

Foto Direng LED 330Q Kablo 10KQ
§ / Direng Direng
x1 x1 x1 x6 x1

Elemanlar:




Devre 6: Foto Direg
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Kod Notlari:

Arduino IDE 'yi A¢// File > Examples > Arduino Kod > Devre # 4

00

|:> analogRead() kullanarak okudugumuz bir analog sinyal,

lightLevel = map(lightLevel, 0, 1023, 0, 255);

0-1023 arasinda bir deger olacaktir. Fakat anologWrite()
kullanarak bir PWM calistirmak istedigimizde, 0-255 arasinda
bir deger isteyecektir. Bu durumda map() fonksiyonunu
kullanarak genis alanlar1 daha dar alanlar olacak sekilde
sikistirabiliriz.

|:> Kullandigimiz map() fonksiyonu siir1 daraltir fakat biz bunu

lightLevel = constrain(lightLevel, 0, 255);

Ne gorecegiz?

Fotodirencinizin algiladig 151k
miktarina gére LEDininiz daha
parlak veya soniik yandigini
gorebilirsiniz. Eger ¢calismiyorsa
devrenizin dogru kuruldugundan
emin olun, konudunuzu yeniden
yiikleyin ve ariza tespit kismini
konrol edin.

Sorun Giderme:

LED Isik Vermiyor
Foto Direng ve LED in baglantilarin: tekrar kontrol
edin.

Isigin Degisimine Tepki Vermiyor

Fotodireng tizerinde baglantilar standart degildir, bu
ylizden baglantilar1 karigtirmus olmaniz miimkiin.
Dogru yerlestirildiginden emin olmak igin iki kez
kontrol edin.

Hala Calismyor

Aydinlatma olarak gok aydinlik veya karanlik bir
odada olabilirsiniz. Isiklar1 duruma gore agin veya
kapatin. Eger yakininizda flag varsa bir de onu
deneyin.

yamnda constrain() komutu kullanarak sayilar1 bu sinir

icerisinde tutacagiz. Eger say1 bu sinir1 agarsa daha bityiik bir

saylya doniisecek. Ama smirin igerisindeyse ayni kalacak.

o A | LSS

Gerg¢ek Hayatta Uygulamalar::

Sokak lambalari geceleri aydinlatmak igin bu tiir
sensorler kullanir.

M



Devre #7

Sicaklik Sensorii

+5 Volt

Sicaklik sensorii adindan da anlagildigs gibi ortam
sicakligini 6l¢mek igin kullanilir. Bu sensoriimiizde 3
adet pin bulunuyor. Pozitif, toprak(GND) ve sinyal
pinleri. Bu devremizde, sicaklik sensériinii Arduino
ile nasil entegre edilecegini 6grenecegiz ve Arduino
IDE'deki serial monitorde sicaklik degerini gorecegiz.

Pin AQ

+5v TMP36
signal (precision
gnd temperature
sensor)
Transistor ve Sicaklik Sensorii birbirlerie
GND A ¢ok benzeyen devre elemanlaridir.
Karigtirdmamaya dikkat edilmelidir.

. (toprak-ground) (-)

Elemanlar:

£
E
=
—
g
=
5
=
o
N
v




Devre 7: Sicaklik Sensorii
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| , | Arduino IDE yi A/ File > Examples > Arduino Kod > Devre # 7

00

Seri monitorii kullanmadan 6nce, baslatmak icin Serial.begin()

. . komutunu ¢agirmaniz gerek. Baglanti hiz1 veya “Baud Hizi*”
Oy Q . .
Serial.begin(9600); :: 9600'dur. ki cihaz birbiriyle baglanti kurdugunda, ikisi de ayni

hiza ayarlanmis olmalidir.

Serial.print() komutu epey zekidir. I¢ine attiginiz hemen hemen her
seyin giktisini verebilir, buna her tiirlii degiskenler de dahildir.

Serial.print(degreesC); |:> Baud: Veri iletiminde modiilatér ¢ikisinda bir saniyede meydana
gelen semboldegisikligidir.

Daha fazla bilgi icin > bttp.//arduino.cc/en/Serial/Print
Serial.print() her seyi ayni satir tizerinde yazdirir. Serial.println() diger

Serial. println(degreesF); :> satira gecis yapar. Bu iki komutu birlikte kullanarak okunmast kolay
metin ve data giktilar olusturabilirsiniz.

Ne gorecegiz?
/

Sicaklik sensoriiniiziin algiladign ~ [AA A
sicaklik degerini Arduino IDE
seri monitériinde okunabiliyor

olarak gi')rebiliyor olmaniz gerek. voltage: 0.73 deg C: 22.75 deg F: 72.96
Eger galismiyorsa devrenizin voltage: 0.73 deg C: 22.75 deg F: 72.96
dogru kuruldugundan emin

. . . voltage: 0.73 deg C: 22.75 deg F: 72.96
olun, kodunuzu yeniden yiikleyin
Ve sorun giderme kismini konrol voltage: 0.73 deg C: 22.75 deg F: 72.96
edin. voltage: 0.73 deg C: 22.75 deg F: 72.96

¥ Autoseroll| Ne line ending [5] | 9600 baud

\\ AN - 0507 PR Ree® aeete®

Sorun Giderme: Gergek Hayatta Uygulamalar::

Goriiniirde Cahisan Bir Sey Yok Klima sistemlerinde sicakhig: takip etmek ve buna gore
Programin gahistigina dair bir gosterge yok mu? ayarlar yapilandirmak i¢in sicaklik sensérleri kullanilir.
Sonuglar gérmek i¢in Arduino IDE seri monitoriini
agmaniz gerek. (Talimatlar 6nceki sayfada mevcut.)

Anlamsiz Ekran

Bu tiir seylerin meydana gelmesinin sebebi seri
monitoriin beklenenden farkli hizda data almasindan
kaynaklaniyor. Diizeltmek igin ise pull-down
kutucuguna tiklayip “baud” yazan yeri “9600 baud”
olarak diizeltmeniz gereklidir.

i
™

68"

N\
i

Z
~
=

Sicaklik Degeri Degismiyor
Sensoriiniizii parmaginizin arasina sikistirarak 1sisini
yiikseltin veya buz torbasi kullanarak sogutmay1 deneyin.




gin 1.5 milisaniyelik bir

gisim sevoyu 90 derece hareket ettirebilir. Bu

Srenecegiz.

gisimine gore servoyu belirli bir

servoyu kontrol edip yénlendirmek igin

Servo motorlar gémiilii elektronik uygulamalar igin

son derece idealdir ¢tinkii donen normal motorlarin
aksine istenilen herhangi bir yonde donebilir. Servoya

ulagan voltaj de;
pozisyona sokabilirsiniz. Orne

de

Servo Motor
PWM kullanmay 6

devrede,

+5v
(Kirmizi)

@ +5 volt
V)

Pin 9

(beyaz)

signal

gnd
(Siyah)
GND
(toprak-ground) (-~

Kablo

Mini Servo

Devre #8



Devre 8: Servo Motor
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Arduino IDE 'yi A¢// File > Examples > Arduino Kod > Devre # 8

00

N
#include kiitiiphaneyi (veya baska bir dosya) taslaginiza (sketch) ekleyen
. N 6zel bir 6niglemcidir. Bu komutu kendiniz yazabilir veya hali hazirda
#include <Servo.h> e e - . . " N
yiiklii olan bir kiitiiphaneyi "sketch / import library" meniisiinden
secebilirsiniz.

Servo kiitiiphanesi servoyu kontrol etmenizi saglayan yeni komut

Servo servol; imkani sunar. Arduino’yu servo kontroliine hazirlarken éncelikle her
|:> servo igin Servo”object” olusturmaniz gereklidir. (Biz “servol” olarak
servol.attach(9); adlandirdik.) Ardindan servoyu bir dijital pine eslestirmeniz “attach”

gereklidir. (Biz pin 9'u kullaniyoruz.)

Servo kiitiiphanesinde write() komutunu kullanarak servonun donecegi derece

servol.write(180); :> araligini (0-180) belirleyebiliriz. unu unutmayn, servo hareket i¢in zaman
ihtiyag duyar, ihtiyaciniza gére delay() komutu kullanarak kisa zaman araliklari
tanimlayabilirsiniz.

Ne gorecegiz?

Servo motorunuzun farkli hizlarda
degisik konumlarda dénebildigini
gorebilirsiniz. Sayet motorunuz hareket
etmiyorsa baglantilarinizi kontrol
ettikten sonra kodunuzun dogru
oldugundan emin olun ve upload edin.
Hatanin kaynagini gormek igin ariza
tespit kismina goz atin.

Sorun Giderme: Gergek Hayatta Uygulamalar::

Servo Donmiiyor: Karsilastiginiz robot kollarda servo motorlar
Farkli renkli kablolar1 olmasina ragmen sasirtic1 sekilde kullamlmaktadur.

motorun ters baglanmus olmasi miimkiin olabiliyor.
Muhtemelen sorununuz bundan kaynaklidir.

Calismamakta Israr Ediyor:
Muhtemelen (kirmuzi ve kahverengi kablolar) 5 Volt ve
toprak(gnd) baglantis1 yanlis yapilmustar.

Oldu Bitti :

Servonuz galistyor fakat kesik hareketler
gergeklestiriyorsa ve Arduino tizerinde yanip sonen bir
151k var ise muhtemelen enerjiniz yetersizdir. Usb
yerine bir adaptér kullanmak bu sorunu ¢ozecektir.




Elemanlar:

>
[y
>
£

Devre #9

Pin9

[ ] Buzzer

—— GND

— (toprak-ground) (-)

Buzzer Kablo

Buzzer

Bu devremizde dijital diinya ve analog diinya
arasinda koprii kuracagiz. Bunun igin bir buzzer
(speaker) kullanacagiz. Tek basina gok heyecan
verici bir sey olmasa da, bir saniyede yiizlerce kez
voltaji agip kapadiginizda buzzer ses tiretecektir.
Birden fazla tiretilmis sesi bir araya getirdiginizde,
kendi miiziginizi elde edebilirsiniz! Bu devre ve
taslak klasik bir ses tiretecektir. Sizi hayal kirikligina
ugratmayacagiz.

+ Buzzer kolayca breadboard
deliklerine uymazsa, hafifce

dondiirmeyi deneyin.




Devre 9: Buzzer
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Kod notlar:

char notes[] = "cdfda ag cdfdg gf ";

=

char names[] = {'c','d','e','f,'g','a','b','C'};

tone(pin, frequency, duration);

=

Ne gorecegiz?

Tabi bir sey duymuyor olmanizda
miimkiin. Eger ¢alismamigsa
baglantilarinizi kontrol ettikten ve
kodunuzu gozden gegirdikten sonra
tekrar upload edin ve hata devam
ederse sorun giderme kismina goz atin. §

!
Sorun Giderme:

Ses Yok
Breadboard tizerindeki bosluklar karigtirmig olmaniz
miimkiin. Cihaz yerlesimini tekrar kontrol edin.

Miizik Calarken Diisiinemiyorum
O halde diistiniirken cihazinizi s6kiin, kullanacaginiz
zaman programi upload edip tekrar monte edin.

Twinkle Twinkle Little Stars Sarkisindan Sikildim
Nasil yapacaginizi 6grendiginize gore artik kendi
sarkilarinizi upload edebilirsiniz.

Arduino IDE 'yi A¢// File > Examples > Arduino Kod > Devre # 9
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Simdiye kadar sadece sayisal verilerle ¢alistik ama Arduino ayni
zamanda metinlerle de galisabilir. Karakterlerin (tek karekterler,
harfler, numaralar, semboller) kendilerine ait tipleri mevcuttur.
Bu tipe “char” diyoruz. Bir karakter diziniz varsa gift tirnak
icerisinde tanimlanabilir. “string” olarak tamimlarsaniz tek tirnak
igerisinde belirtilmelidir.

Arduino'nun kullanigh komutlarindan biri de tone()
fonksiyonudur. Bu fonksiyon bir ¢ikis pinini belirli bir frekansda
calistirabiliyor, boylece buzzer ve speakerlar igin ideal hale geliyor.
Eger belirli bir siire tanimlayacak olursaniz(milisaniye cinsinden) o
siire zarfindan ses olusturacak ve ardindan suracaktir. Eger siire

belirmememigseniz, sonsuza kadar ses tiretebilir.

(Tabiki noTone() komutu kullanarak bunu sonlandirabilirsiniz.)

Gerg¢ek Hayatta Uygulamalar::

Modern megafonlarda giiglendirilmis buzzerlar
kullaniliyor. Gergekten fazla giiriltiilii olmalarina
ragmen insanlarn ilgisini gekmekte yeterince etkili.

@@@



Devre #10

Motor Dondiirmek

Diren  (3300hm) Servo motorlarla oynadiginiz zamanlardan 6ncesini
(turuncu-turuncu-kahverengi) ) ! e e
hatirlayin. $imdi biraz da motorun déniisiiyle
base ugrasacagiz. Bunun igin transistore ihtiyacimiz var
transistor ¢iinkii transistorler Arduino’nun yapabildiginden
collector

P2N2222AG
/. daha biiyiik miktarlarda akim doniistiirebiliyor.
emitter i . o
Transistor kullandiginizda maximum seviyesine
bakarak kullaniminiz igin yeterince uygun olup
Diyot o . .
olmadigina karar verin. Bu devre i¢in 40V ve 200
mA'lik transistor isimizi goriir. Oyuncak
moturumuz igin yeter de artar!

Transistor ve Sicaklik Sensorii birbirlerie
¢ok benzeyen devre elemanlaridir.

Karistilmamaya dikkat edilmelidir.

Transistér g, | Diyot DC Moto Kablo 330Q
P2N2222AG (52 1N4148 Direng
x1 x1 x6 x1

GND
(toprak-ground) (-)

motor
Multimetre




Devre 10: Motor Dondiirmek
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Kod Notlare: 0 °

Arduino seri portlar1 data génderimi igin oldugu gibi data alimu igin

de kullanilabilir ¢iinkii herhangi bir zaman da data aktarimu olabilir.
while (Serial.availableQ) > 0) |:> Arduino siz bu bilgiyi kullanana kadar depolar ve korur.

The Serial.available() komutu portunuza ulagnus fakat taslaginizda
(sketch) heniiz kullamlmarus olan karakter numaralarim geri getirir.

Sifir, ulagmus data yok anlamina gelir.

Portunuzda bekleyen hali hazirda dataniz mevcut ise,
kullanacabilecegiz bir kag yontem var. Port igerisine sayilari
girmeye bagladigimizdan beri Serial.parselnt() komutu ile
speed = Serial.parseInt(); |:> ayirma ve integer numaralari kendisini olugturan karakterlere
ayrstirmak icin kulllantyoruz. Eger portunuza “1” 70 ”0”

yazarsaniz, bu fonksiyon bu numaralar1 100 olarak gevirecektir.

Ne gorecegiz?

Eger bilesenleri dogru yerlestirmisseniz DC
motorunuzun ¢aligmasi gerek. Eger
caligmiyorsa ariza tespit kismini kontrol
edin.

Sorun Giderme: Gergek Hayatta Uygulamalar::

Motor Dénmiiyor Radio Kontrollii RC arabalar, DC motor kullanilar.
Kendi transistoriniizi kullaniyorsamz, data sheeti
iki kez kontrol ederek pinout'un P2N2222AG ile
uyumlu olup olmadigini tespit edin.

Calismamaya Devam Ediyor

Kendi motorunuzu kullaniyorsaniz motorunuzu
5V ile calistirmay1 deneyin ve daha fazla gii¢ gekip
gekmedigini kontrol edin.

Calismamakta Israrc
Bazen Arduino bilgisayarla baglantisin1 koparabilir.
USB girisinizi gikarip tekrar takin.




Devre #11

Direng  (ssoohm)
[ ——

+5volt trans

P2N2222AG

collector emitter

Direng  (33oohm)
(uruncu-uranca-kahvereng

woo

Diyot

oo

ON

ON

LED LED

—@ + 5 volt

Bu devrede, role kontrolii igin Devre#10' da 6grendiklerimizi
kullanacagz. Role basitge sdyleyecek olursak elektriksel
olarak kontrol edilen mekanik bir anahtardir. Bu zararsiz
goriinen plastik kutunun igerisinde elektromagnet
bulunuyor. Ne zaman ki fazla enerji ile yiiklenirse anahtar1
agryor. Bu devrede Arduino’nuza daha giiglii yetenekler
kazandirmayi ve bir réleyi profesyonelce kullanmay:
Ogreneceksiniz.

A

istor

Role kapaliyken, COM(common) pini NC
(Normally Closed) pinine baglanir.

Role agikken, COM(common) pini NO
(Normally Open) pinine baglanir.

GND

(toprak-ground) (-)

Transistor
P2N2222AG

=
o
=
®

Elemanlar:

x1

Diyot
1N4148
x1

330Q

LED Kablo
Direng /
x2 x2 x14




Devre 11: Role
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Kod Notlare:

=

digitalWrite(relayPin, HIGH);

digitalWrite(relayPin, LOW);

=

Ne gorecegiz?

Role baglant: klik sesini duymus
olmaniz gerek ve ardindan 1
saniyelik aralikta LED'leri
aydinliklarini kendi aralarinda
degistirdiklerini gorebilirsiniz. Eger
devreniz ¢alismamugsa devre
kurulumunuzu kontrol edin,
kodlarinizi tekrar upload edin.

Sorun Giderme:

LED Isik Vermiyor
LEDi dogru taktigimizdan emin olun. Uzun olan ug
porzitif ugtur.

Klik Sesi Gelmiyor
Transistor veya bobin galismiyorsa transistoriin dogru

sekilde takili oldugundan emin olun.
Calismamakta Israrci

Réle breadboard ile kullanimak igin degil
lehimlenmek i¢in dizayn edilmis olabilir. Breadboard
deliklerine tam oturmasi igin gerektigi kadar ittirmeyi
deneyin.

JL Arduino IDE 'yi A¢// File > Examples > Arduino Kod > Devre # 11
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Transistor calismaya bagladiginda role bobinine enerji saglar.
Boylece role anahtari(switch) kapanir. Bu kapanma ile rélenin
COM pini NO(Normally Open) pinine baglanmis olur. Baglant:
saglandiktan sonra pinler ¢alismaya baslayacaktir. (Biz galistigin
gormeniz i¢in LED kullandik ama bagka bir sey de kullanilabilir
tabi ki.)

Réle NC denen ilave bir baglantiya sahiptir. Réle kapali oldugunda
NC pini COM pini ile baglant1 kurar. Rélenin agik veya kapali
olmasina bagh olarak iki pinden birini kullanabilirsiniz. Ayn1

zamanda bu iki pini iki cihazin enerjisini degistirmek i¢in de

kullanabilirsiniz.

Gerg¢ek Hayatta Uygulamalar::

Garaj kapilarini agmak igin role kullamilir. Eger
dikkatli dinlerseniz klik sesini duyabilirsiniz.




Devre #12

+5 volt
Direng  (3300hm) | Epyer

(turuncu-turuncu-kahverengi)
——WW\—K——15 1® wJ
——MWW—Kt 1 1

clock

Shift Register

$imdi de entegre devrelere adim atiyoruz. Bu devremizde

Arduinonuza ilaveten 8 output verir ve Arduino'nun sadece

shift register hakkinda her seyi 6greneceksiniz. Shift register

latch

3 pini kullanihir. Bu devrede 8 adet LED 'i kontrol etmek igin

——WW——]2 12

data

shift register kullanacagyz.

—— W —K——f3 14

Gl R

(topralgroundrs

IC LED 330Q
/ Diren

x1 x8

S SRR

Elemanlar:

—WW—KI—"B”__l_

o P PP L L

Kablo '
© Breadboard iizerinde “e5”
ve “f5” arasinda gentigi
x8 <19 hizalayn. ’




Devre 14: Shift Register
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Kod Notlare: o °

SPI(Serial Peripheral Interface) arayiiziinii kullanmak igin shift register
(ve birgok farkli parga) ile iletisim kuracaksmniz. MSBFIRST parametresi
. . . . y bireysel bitlere génderilen komutlar belirler, bu durumda MSBFIRST

shiftOut(datapin, clockpin, MSBFIRST, data); Y §

gonderiyoruz.

Bitler bilgisayar hafizasmin en kiigiik yaps taglaridur, her bit 1 veya 0
depolayabilir. Daha biiyiik sayilar bitlerden olugan dizilerle depolanir. Bazen
bu bitler iizerinde oynama yapmak isteriz. Ornegin 8 biti shift registera

bitWrite(data,desiredPin,desiredState); L . . -
gonderiyoruz ve LED'i agip kapatmasi igin 1 veya 0 yapmasin istiyoruz.

Arduino bitWrite() gibi basit komutlariyla bu islemi gerceklestirebiliyor.

Ne gorecegiz?

Devre 4’ te oldugu gibi LED 'in
yandigini gérmeniz gerek (Tek fark
shift register kullandik.) Eger LED
151k vermiyorsa baglantilarinizi
kontrol edin ve kodunuzu tekrar
upload edin.

Sorun Giderme: Gerg¢ek Hayatta Uygulamalar::

LED Patlad: Devre 4 manti] ile, birden ¢ok LED kullanarak kayan
Bu bir ¢ok kez bagimiza geldi. Sebebi entegrenin ters yaz1 ekranlari yapabilirsiniz.

takilmasindan kaynaklaniyor. Eger hemen
diizeltirseniz higbir seyi bozmadan durumu
kurtarabilirsiniz.

Calismamaya Devam Ediyor
Siirekli ayni seyi soylityoruz ama muhtelemen
kablolar yanlis takilmugtur. ‘ {




Ve Sonuna Geldik.

Sitemizi ziyaret edebilirsiniz!

Miihendisler, Teknik Elemanlar, Makerlar, Hacker'lar, hobi
elektronik seven herkes i¢in agik kaynakli bir ¢ok yerli ve yabanci
kaynaktan yararlanarak sizler "AkademikPort Arduino
Baglangi¢ Projeleri” egitimini hazirladik. Daha ¢ok egitim ve
projelere ulasmak icin www.akademikport.com adresini ziyaret
edebilirsiniz. Bir sonraki egitimde gortismek tizere.

E i Emre ARSLAN
( ) AkademikPort Kurumsal illiskiler Koordinatérii

Sparkfun SIK GUIDE

Adafruit.com

Arduino - Coskun Tasdemir

Instructables.com

NOTLAR
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Ve Sonuna Geldik.

Sitemizi ziyaret edebilirsiniz!

Miihendisler, Teknik Elemanlar, Maker'lar, Hacker'lar, hobi
elektronik seven herkes i¢in agik kaynakli bir ok yerli ve yabanci
kaynaktan yararlanarak sizler "AkademikPort Arduino Baslangic
Projeleri” egitimini hazirladik. Daha ok egitim ve projelere
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E i Emre ARSLAN
( ) AkademikPort Kurumsal illiskiler Koordinatérii

Sparkfun SIK GUIDE

Adafruit.com
Arduino - Coskun Tasdemir

Instructables.com

NOTLAR



3*%3
. «%




	AkademikPort Arduino Projeleri Son Hal - Copy.compressed
	AkademikPort Arduino
	Arduino Projeleri
	kapak-ön - Copy
	AkademikPort Örnek Projeleri
	Cilt1
	Cilt1
	Arduino başlangıç4






	AkademikPort Arduino Projeleri Son Hal.compressed
	AkademikPort Arduino
	Arduino Projeleri
	AkademikPort Örnek Projeleri
	Cilt1
	Arduino Başlangıç5

	devam
	Arduino Başlangıç6
	Arduino Başlangıç7
	Arduino Başlangıç8



	AkademikPort Elektronik Devre Elemanları Eğitimi
	kapak-arka


	AkademikPort Elektronik Devre Elemanları Eğitimi
	kapak-arka





